Sketchucation SCF License

Instructions to Users
version 6.0 — January 2023

The present user-manual gives you instructions on how to license an extension on Sketchucation. There are only
2 steps: Purchase and Activate.
Note:
= You need an Internet connection for purchasing and activating the license. But, once the license is
activated, you can work offline: license checking is done locally on your computer, with periodic checks

online to verify the licensing.
= A license is valid for all versions of Sketchup, past and future. Likewise, you can upgrade the extension
independently of the license. So, licensing an extension is done once.

1. Requirements

1) You must have a valid registration on Sketchucation (free account is enough - Premium members
usually get a significant discount on licenses). See https://sketchucation.com/register.php for registration.

2) Install the Sketchucation ExtensionStore extension, v4.3 or above. It includes the management of
licenses and many other features to install other extensions and keep them up to date.

Sketchucation ExtensionStore: https://sketchucation.com/pluginstore?pln=SketchUcationTools

2. Purchasing a license

Licensed extensions have a License... menu item in their menu'. It displays a dialog box to manage
everything about licenses. When the extension is not yet licensed, the dialog box displays as below:

@ License extension: FredoSpline — O x
U FredoSpline Lol
6.0e - 72 - SU22 Not Licensed Hep...
SCF Member: email:
License ID: Date Purchase:
License Type: Validity:
HW ID: Seats:

You must be connected to Infernet to Purchase, Validate or Release a License

Click on button | Purchase License | You will be directed to the Purchase page of the extension on the

Sketchucation web site (you will need to sign in):

Duration
License Type (days) Price Seats Comment
FredoSpline Perpetual Unlimited 22.00 3 Includes all features to create, edit and convert a variety of splines and curves. Unlimited validity
License EUR Buy Now

7.00EUR 3 Includes all features to create, edit and convert a variety of splines and curves, Valid 21 days from the purchase
date.

FredoSpline Rush License 2
Buy Now

@
c
=<

1 Forinstance, FredoSpline would have the menu entry in Tools > Fredo6 Collection > FredoSpline > License...
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Select the type of license and click on . You will be prompted for an email address where to send
you the Purchased license file.

Buy License:

Enter the email address you wish to receive your license file to.

Email address:

B Pay with PayPal

Then, click on button | Pay with PayPal | The next page is a standard shopping basket: select the quantity

of license and the form of payment (PayPal or credit/debit card):

Your shopping cart Continue shopping
Description Price Quantity Total Order Summary
Item total €7.00
FredoSpline Full 20 Days . €7.00 .. €7.00 em total
more Total €7.00 EUR
Remove

P PayPal Checkout
or
Check Out

Pay without a PayPal account

Once you have paid, you receive an email from Sketchucation with the Purchased License File? in
attachment. This is your proof of purchase of the extension license; Therefore, you should save the file in
a safe place on your computer where you can retrieve it.

IMPORTANT: The email is sent within 24 hours. So be patient, but if you don’t receive the email, check the
SpAM folder of your email application.

You can also go to the dedicated my-licenses page on Sketchucation, which lists all your license. From this
page, you download the Purchased License File at any time. The address of the my-licenses page is

https://sketchucation.com/webshop/my-licences.php

Your Licences:

If you purchased your licence just now, please let our system a few minutes to prepare it for you.

Duration Created
D Plugin License Type (days) (DD/MM/YYYY) Seats Email Download
19442 FredoSpline @ FredoSpline Perpetual License Unlimited 12/01/2021 2/3 -
Download
19456 FredoSpline @ FredoSpline Rush License 21 13/01/2021 1/3 =
Download

19733 FredoCorner @ FredoCorner Perpetual License Unlimited 26/01/2021 3/3~
Download

2 The file has the form SCF_Purchased_License_<extension>_<license type>_<date>.scflicense. It is a text file.
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3. The License dialog box

The License dialog box manages the License status and activation / deactivation of your license for each

plugin.
License extension: FredoSpline = X
p! [m]
FredoSpline
Help...
@ 6.1a-72-5U23 Not Licensed

SCF Member: email:

License ID: Date Purchase:

License Type: Validity:

HW ID: Seats:

You must be connected to Internet to Purchase, Validate or Release a License

It can be invoked at any time from the submenu License... of the plugin, for instance Tools > Fredo6
Collection > FredoSpline > License...

It can also be invoked from the warning message box informing you from the expiration of the license:

§D Trial Period Expired: FredoSpline = [m] ®
Trial Period Expired: FredoSpline =
Trial period has expired since Wed 15 Dec 2021
You now need to get a License to continue using the extension
Help on Licensing... Manage License... Done

Simply click on the button Manage License to display the License dialog box.

4. Activating the License

The objective is to assign the purchased license to your computer. In the License dialog box, click on the

button.

@ License extension: FredoSpline = m} X
- FredoSpline
Help..
U 6.0e - 72 - SU22 Not Licensed
SCF Member: email:
License ID: Date Purchase:
License Type: Validity:
HW ID: Seats:

You must be connected to Internet fo Purchase, Validate or Release a License

Purchase License... | [aleiZ:1CHR#E

SCF License v6.0 - Instructions to Users © Sketchucation - January 2023



This opens the standard File selection dialog in your system. Browse to locate the Purchased License file.

® License File for FredoSpline x
T <« Ruby > Ruby » Sketchup Licenses * SCF Licenses ~ (&) O Search SCF Licenses

Organize New folder =~ W @

@ OneDrive ~  Name Date modified Tyl
& Fredo Six
& This PC

E SCF_Purchased_License_FredoSpline_NORMAL_20210112.5cflicense 12-Jan-21 1718 sC

E SCF_Purchased_License_FredoSpline RUSH_20210113.scflicense 13-Jan-21 1324 SC
2B 3D Objects

I Desktop
|5 Documents
¥ Downloads
J” Music

=] Pictures
i Videos

& 0S(@

r Libraries 1 >

File name: ~ | | *FredoSpline* scflicense ~

After selection, the License dialog box should now show that the extension is licensed.

9 License extension: FredoSpline = o X
FredoSpline
U 6.0e - 72 - SU22 OK - Active
SCF Member: fredo6 email: email of Fredo
License ID: 28715 Date Purchase: 16 Feb 2022 - 15:00
License Type: NORMAL Validity: Infinite
HW ID: GJ1567342582.0V Seats: Max=3 - Taken=2 - Left=1

You must be connected fo Internet fo Purchase, Validate or Release a License

Purchase License... H Activate License H Release License ‘

Some licenses are valid for a limited period of time. This will be indicated if this is the case.

9 License extension: FredoSpline = o X
U FredoSp!me ) Lok
6.0e - 72 - SU22 OK - Active [Expires on 26 Jan 2023]
SCF Member: fredo6 email: email of Fredo
License ID: 100494 Date Purchase: 05 Jan 2023 - 09:49
License Type: RUSH Validity: 21 days [Thu 26 Jan 2023 - 09h49]
HW ID: GJ1567342582.0V Seats: Max=3 - Taken=1 - Left=2

You must be connected fo Internet fo Purchase, Validate or Release a License

Purchase License... H Activate License H Release License ‘

YOU ARE DONE
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5. Releasing a license

Licenses come with a number of allocated seats, typically 3. This means that you can activate it on up to
3 computers. The number of seats taken and free is indicated in the License dialog box.

In the License dialog box, click on the button. Note that you must be connected to Internet
for the Release License operation.

@ License extension: FredoSpline = O %
U FredoSplme ) Help..
6.0e - 72 - SU22 OK - Active [Expires on 26 Jan 2023]
SCF Member: fredo6 email: email of Fredo
License ID: 100494 Date Purchase: 05 Jan 2023 - 09:49
License Type: RUSH Validity: 21 days [Thu 26 Jan 2023 - 09h49]
HW ID: GJ1567342582.0V Seats: Max=3 - Taken=1 - Left=2

You must be connected to Infernet to Purchase, Validate or Release a License

Purchase License. .. H Activate License ||| Release License ‘

You will be prompted for confirmation.

SketchUp X

o Please confirm that you wish to remaove the license for Fredo5pline

Yes No
After Releasing, you are back to a non-licensed state.
@ License extension: FredoSpline = O %
- FredoSpline
Help. ..
U 6.0e - 72 - SU22 Not Licensed =
SCF Member: email:
License |D: Date Purchase:
License Type: Validity:
HW ID: Seats:

You must be connected to Infernet to Purchase, Validate or Release a License

Note: you can release and re-validate a purchased license on the same device as many times as you wish.
This will always keep the same seat assigned to the computer.
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6. Global License Status

Go to the menu Extensions > Sketchucation > Global License Status... This will open a dialog box showing
all licensed extensions installed in Sketchup, with their status: licensed or not licensed.

$ Global status of plugins under SCF License = [m] *
Global status of plugins under SCF License
6.0e - 72 - SU22
|Plugin License Type License ID |SCF Member Date Purchase Validity
ClothWorks FORPREMIUM 6795 fredo6 30 Mar 2018 - 09:17 |Infinite details
Curviloft CORP30 36727 fredo6 26 Mar 2022 - 12:33 |Infinite details By
Curvizard NORMAL 29194 fredo6 01 Mar 2022 - 20:26 |Infinite details
FredoCorner NORMAL 28725 fredo6 16 Feb 2022 - 17:18 |Infinite details
FredoGhost NORMAL 21664 fredo6 03 Apr 2021 - 17:09 |Infinite details
FredoPortrait NORMAL 20311 fredo6 17 Feb 2021 - 17:48 |Infinite details
FredoScale CORP30 36726 fredo6 26 Mar 2022 - 12:33  |Infinite details
FredoSpline RUSH 28636 fredo6 14 Feb 2022 - 09:06 |Expired details
JointPushPull CORP30 36728  |fredo6 26 Mar 2022 - 12:33 |Infinite details v
RoundCorner NORMAL 28368 fredo6 04 Feb 2022 - 10:58 |Infinite details
License File Location.. | ‘ My Licenses at Sketchucation... Help .

In the example above, all extensions are licensed, except FredoSpline (expired).

Clicking on the link details will open the License dialog box for the selected extension.
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7. Mpy-licenses page on Sketchucation

At any time, you can consult the list of all your licenses and seat information on Sketchucation. The
address of the my-licenses page is (you may need to sign in):

https://sketchucation.com/webshop/my-licences.php

You can also access this page from the | My Licenses at Sketchucation | button in the Global Status dialog.

Your Licences:
If you purchased your licence just now, please let our system a few minutes to prepare it for you.
Duration Created
D Plugin License Type (days) (DD/MM/YYYY) Seats Email Download
19442 FredoSpline @ FredoSpline Perpetual License Unlimited 12/01/2021 3/3 -
Download
Seats:
s Seat ID: 15661; HW ID: A]1610524400.0E; Date of activation: 07/02/2021
= Seat ID: 22919; HW ID: QE1619098909.0R; Date of activation: 13/02/2022
« SeatID: 22936; HW ID: G|1567342582.0V; Date of activation: 14/02/2022
19456 FredoSpline @ FredoSpline Rush License 21 13/01/2021 13
Download
19733 FredoCorner @ FredoCorner Perpetual License Unlimited 26/01/2021 3/3~
Download

This page allows you to download the Purchased License File in case you have lost it, or right after purchase.

It also allows to identify the Seats assigned to the license, with for each the date of activation. The HW ID
identifier’ in the page corresponds to the HW ID displayed in the License dialog box of the extension on the
computer.

Date Purchase:

Seats:

HW ID: GJ1567342582.0V

3 The HW ID is a unique, randomly generated code identifying the computer where the license is activated.

SCF License v6.0 - Instructions to Users © Sketchucation - January 2023 7



8. Additional Remarks

You can validate the same Purchased License File on several computers. The number of seats (e.g.
computers) taken is stored on the Sketchucation Server. However, if you have the License dialog box
opened and do a validation in parallel on other computers, you may need to refresh the information by

just clicking on the button.

There is a history of license-related actions for the device. Just click on the button to
display the log of activities. This may be useful if you have license validation problems and you need
to interact with Sketchucation.

9 License History = [m} X
IE el s License History - FredoSpline Help
Date Event Code Description

06-Jan-23 14:30:57  |validate_success Validation successful on Sketchucation - License: 28636 (RUSH) SCF user: fredo6

05-Jan-23 11:33:38 purchase_request Purchase request at hitps:/isketchucation.com/purchase_php?plugin=FredoSpline 6
05-Jan-23 11:33:31 purchase_request Purchase request at https:/isketchucation.com/purchase php?plugin=FredoSpline

05-Jan-23 11:33:08  |validate_success Validation successful on Sketchucation - License: 28715 (NORMAL) SCF user: fredoB

05-Jan-23 11:31:40  |validate_success Validation successful on Sketchucation - License: 19456 (RUSH) SCF user: fredo6

05-Jan-23 10:57:40  |validate_success Validation successful on Sketchucation - License: 100494 (RUSH) SCF user: fredo6

05-Jan-23 10:62:26  |validate_success Validation successful on Sketchucation - License: 19456 (RUSH) SCF user: fredo6

05-Jan-23 10:50:59 release_success Release successful on Sketchucation - License: 28715 (NORMAL) SCF user: fredof

05-Jan-23 10:47:08  |validate_success Validation successful on Sketchucation —- License: 28715 (NORMAL) SCF user: fredo6

05-Jan-23 10:43:17 release_success Release successful on Sketchucation - License: 28715 (NORMAL) SCF user: fredoB

21-Dec-22 18:06:56 |validate_success Validation successful on Sketchucation —- License: 28715 (NORMAL) SCF user: fredo6

11-Dec-22 18:48:10  |validate_success Validation successful on Sketchucation —- License: 28715 (NORMAL) SCF user: fredoB

26-Nov-22 15:43:56  |release_success Release successful on Sketchucation - License: 28715 (NORMAL) SCF user: fredo6

20-Sep-22 06:42:11  |validate_success Validation successful on Sketchucation - License: 28715 (NORMAL) SCF user: fredo6

20-Sep-22 06:35:17  |release_success Rels It on — License: 28715 (NORMAL) SCF user: fredof e

License File Location .

Lines in green means successful operation; in errors; in white information.

SCF License relies on the Sketchucation Server and some local files. Validation, Release and Seat
refresh requires an interaction with the Sketchucation Server. This is why you need to be connected to
Internet for these operations. However, when you launch Sketchup and use the licensed extension, you
can be offline. All checks are done locally.

The local files are stored in a reserved directory, which you can access via the | License File Location...
button in the History panel, or in the Global License Status panel. This reserved directory is independent
of the Sketchup version (this is why you can license extensions across Sketchup versions).

There are 2 unique files by computer and one local license file per licensed extension.

| SCFLicense_Souvenir_this_computer.xt
| SCFLicenselog bt
| SCFLicenseSignature - DO NOT MODIFY OR DELETE.txt

All files are in plain text (.txt) but encrypted (except the History log).

e SCFLicenseSignature - DO NOT MODIFY OR DELETE.txt identifies your computer for all
licensed extensions.

e SCFLicenseLog.txt is simply the history log

e For each licensed extension, there is a local license file with the name of the extension:
SCFLicense <extension>_this_computer.txt.
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VERY IMPORTANT: NEVER, Never alter these files or move them around or delete them. This
would simply invalidate your license(s).

The exchange of information between your Computer and the Sketchucation Servers does not
include any private information from your computer.

Your computer is identified by a unique token attributed randomly at the first license validation. It is
not the ‘computer name’ of the computer. The token is stored in the signature file.

The information exchanged with the Sketchucation Server only comprised this token, the Sketchucation
pseudo (used for login) and the email address which you have given at purchase time.
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